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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Introduction

This document describes how to add a Yaskawa AC Drive with an SI-EP3 Option to a PROFINET network using the

Siemens Step 7 software version 5.4.

Intended Audience

This document is intended for those involved in designing, installing and/or commissioning a PROFINET system including
Yaskawa AC Drives. It is assumed that the reader is familiar with Yaskawa AC Drives, PROFINET and Siemens Step 7
programming. Familiarity with the SI-EP3 Option and with the A1000 and V1000 installation guides and technical manuals is

highly recommended.
References

Siemens documentation may be downloaded from
49948856
45531107

Following manuals may be downloaded from
SIEPYEACOMO07

SIEPYEACOMO06

SIEPC71061641

SIEPC71060618

PROFINET information may be downloaded from

http://support.automation.siecmens.com
SIMATIC PROFINET with STEP 7
SIMATIC Programming with STEP 7 V5.4

www.yaskawa.com

1000-Series Option SI-EP3 PROFINET Technical Manual
V1000-Series Option SI-EP3/V PROFINET Technical Manual
Yaskawa 1000 Series AC Drive Technical Manual

Yaskawa V1000 AC Drive Technical Manual

http://www.profibus.com/technology/profinet/
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software
Create Step 7 Project

Create Project

Select New from the

Select OK

Select File /
New

Enter project Name

Select OK

Open the Step 7 software

File menu

Enter the project Name

T} SIMATIC Manager

"New Project’ Wizard...

Archive...
Retrieve...

Page Setup...

1 Accessible Nodes — MPI

Exit Alt+F4

N

Creates a new project or a new library.

Figure 1 -- Create Project

) SIMATIC Manager
File PLC View Options Window He

O |2 | 7| @2

User projects | Libraries | Multiprajects I

Mame | Storage path |

I™ Addto current multipraject

arne: Type:
|PROFInet [p,oiect -

™ E Libran
Storage location [path):

IC:\F‘rogram Files\Siemens\Step7he 7proj Erowse... |
QK | Cancel | Help |

Press F1 to get Help. A

N

Figure 2 -- Project Name
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software
Add Station

e Select Station from the Insert menu
e  Select the Station Type (SIMANTEC 300 Station for this example)
e  Double Click on Hardware

LJ‘SIMATIC Manager - [PROFInet — C:\Program Files\Siemens\StepT\s7proj\PROFInet]
d

1 SIMATIC 400 Station

| <o Fter > D% s BEMD|

2 SIMATIC 300 Station
/ : P 3 SIMATIC H Station
4 SIMATIC PC Station
Select Insert i s
& SIMATIC S5
. MY Software b 7 PGIPC
Station =
Symbol Table
/ Text Library »
Select Station Type Exferil Souse.
Inserts SIMATIC 300 Station at the cursor position. v
Figure 3 -- Select Station
r_.'! SIMATIC Manager - [PROFInet — C:\Program Files\Siemens\Stepf\s7proj\PROFInet]
% File Edit Insert PLC View Options Window Help —|5'_|i|
0|80 % e dalz %=k & |[<No Fer> % e ([ BmEM
PR OFlnet “%Ha
Double Click on

Hardware /

Press F1 to get Help. P/IP(Auto) -> ASIX AX8E 178 USE2.0
4

Figure 4 -- Open Hardware Configuration
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Add GSD File

Select Install
Select Close

Select Options/

Install GSD File

Select Install GSD File from the Options menu
Select the GSD file to install

[2 Hw Config - [SIMATIC

@l§ Station Edit Insert PLC

0{1) (Configuration) — PROFInet]

[DassaTEee|

Install HW Updates ...

™~ Install GSD File...

Find in Service & Support...

Create GSD file for I-Device...

4] |

s

Options Window Help =
Customize... Ctri+Alt=E
Specify Module... - ol x|
Configure Network >
Symbol Table CHrI+AI+T Eind | Elﬂ
Report System Error... Profile: IStandard j
LI B 2 PROFIBUS DP
Update Catalog A2 PROFIBUS-PA

SIMATIC 200
SIMATIC 400

-8, SIMATIC PC Station

SIMATIC PC Based Control 3004400

and C7 [distributed rack]

PROFIBUS-DP slaves for SIMATIC 57, M7, &¢

Installs new GSD files in the system and updates the contents of the catalog, | | e
Figure 5 -- Install GSD File
. [0
Select GSD File Bly station Edit Insert  Ipstall GSD Files: — Ifmm the directory j _ & x|
Location ]
J U=zs g‘“‘ | é IC.\Trans\GSD Browse ... |
o=
Felease Wersion “:l: ﬁ=|
Select e Default =

SI-EP3 GSD File ="

Select Install \

YASKOACE gsd

Dietault

(5tation

Select Close
\\ i

| showLeg Select Al

Deselect Al

k)

:
Press F1 to get Help. E‘\ Cose |

Fi ased Control 300/400

for SIMATIC 57, M7, T.Sl

Help

[ 2

Figure 6 -- Select SI-EP3 GSD File
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Select Insert Object from the Object menu

Add CPU

[ ]

e Select Station Type, Rack and Rail
e Select CPU from catalog

[ ]

Select Insert &

Insert Object

Select Station ——"

Select Rack /
Select Rail /

Select CPU

From Catalog And
Drag it to designated
Slot in system rack

Drag CPU to highlighted slot in the system rack

Er; HW Config - [SIMATIC 300(1} (Configuration) — PROFinet]
Insert PLC View Options Window Help

Insert Object...
Replace Object...

Master System
PROFIHET; 10 System

4] |

_|& =
=
& o=
Find: | ﬁ:l: #i
Profile: IStandard j
Y PROFIBUS DP
B2 PROFIBUS P&
B2 PROFINET 1D
SIMATIC 300
SIMATIC 400

SIMATIC PC Baszed Control 2004400
B SIMATIC PC Station

PROFIBUS-DP slaves for SIMATIC 57, M7,
and C7 [distributed rack]

%

Inserts an object to be selected at the position marked.

=

Figure 7 -- Insert CPU Object

W Config - [SIMATIC 300(1) (Configuration) — PROFinet]

“ Station Edit Insert PLC Yiew Options Window Help

e
D22 %8 v e daa HE B
% CEOFIBUS DP = BT
b FROFINET IO Frd | “jl: gr|
[ ace FProfile IStandald j
G, = B PR OF
=3 Rail 2 PROFIBUS P&
/ 22 PROFINET ID
B SIMATIC 300
B SIMATIC 400

4| |

SIMATIC PC Based Control 3004400
B SIMATIC PC Station

PROFIBUS-DP slaves for SIMATIC 57, M7,
and C7 [distributed rack)

%

Press F1 to get Help.

[cha

[ Hw Config - [SIMATIC 300(1) (Configuration) —- PROFinet]

“Mm Edit Insert PLC View Options Window Help

Figure 8 -- Define Inserted Object Type

1= x|
(0320 %5 |ee | d@aBD %2 K
— - ol
- ) UR = End | nﬂ nﬂ
i - Profile: I Standard j
4 ~D -] CPU 315 -]
5 ~ a3 -3 CPU 31520P
& ~ .g. =3 CPU 3152 PN/DP
= :
o I \ \
< N

=23 cPU 36

BES7 315-2EH13-04B0 il
286 KB waork memary; 0.1 me/1000
~ | ||instuctions; PROFIMET connection; 57
» Communication [loadable FBs/FCs); LI

-
3

Figure 9 -- Add CPU to System Rack
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Configure CPU
o  Enter CPU IP Address and Subnet Mask
e Add network
e  Enter network name
e Select OK
(LMW Confia - [SIMATIC 30004 (€] propertics - Ethernet interface PH-IO (R0/52.2)
Stati Edit I it PLC )
m ion nsel = —— | = Iﬂ
D & a&w
ol x|
If & subret s selected, :
Enter IP address Hw: :Je)d av:lable addresses are suggested. Ll || ni-l’
192.168.2.1 & \ tandard j
4 1e addiezs 192.168.02.1 oy 1 CPU 315 -l
5 | % Donotuse router 11 CPU 3152DP
6 w Enhn £ Userouter ] CPU 3152 PN/DP
7 (] 6EST 315266100680
= Address:  [192.168.02.1 - F_-| BEST 315-2EH13-0480
Subnet: o l— ¥2.3 J
Enter Subnet mask — = ] 25
- [8 v2B

255.255.255.0

F_ Mo |
Froperties.. |

Select New = I
To add network

Del_elel

<

1] CPLU 31 SF-2DP

1] CPU 315F-2 PN/DP

1] CPU 316

H13-04B0 I f<|
memary; 0.1 ms/1000

PROFINET connection; 57

bn [loadable FBs/FCs);

oK | Cancel |  Hep | =
Insertion possible - | cha
Figure 10 -- Add IP Address and PROFINET Network
L W Config - [SIMATIC 300(1) e
[y Station Edit Insert PLC
Inze-2 &a| =
General | ol x
Nams: [PROFinet |
7 subnet ID: 001A | - [0004 Lrdard j
Project path: [ CPU 315 |
Enter network Name = Storage location CPU 3152DP
2 of the project: |C:\Program Files\Siemens'\Step7's7proj\PROFinet CPU 3152 PN/DP
7 {3 6E57 315-2EG10-04B0
= 2eiEs | (3 6E57 315-2EH1 30480
Date created: 11/11/2011 02:23:15 PM " J
Last modified: 11/11/201102:23:15 PM
Commert: =] CPU 315F-2DP
Select OK CPU 315F-2 PN/DP
\ CPU 316
i<|
LI emory D‘I ms/1000
| ROFIMET connectian; 57
4 [loadable FB2/FCs); o
Coes |t I_%—',_
Insertion possible - Chg 2
Figure 11 -- Configure PROFINET Network
57 Config  [SWATIC 30001
[y Station Edit Insert PLC -2 x|
Genersl  Parameters
B = |
D8 (&8
Dixl
F a subnet is selected, :
1 the next availsble addresses are suggested. ] | ﬂfl
§ tandard j
4 B addres 192.168.2.1 ey L1 CPU 315 -l
5 — | Donotuse router 1] CPU 152D
& Subnet mask: 255.255.265.0 - :| CPU 3152 PN/DP
7 = (] BES7 315266100480
o Address:  [152.168.2.1 L. BES7 315-2EH13-0480
Subnet: -8 w23 J
- vzs
— not networked — | Hew... i -1® v2B
Select OK : 1] CPU 315F-2 DP
\ ﬂl L] CPU 315F-2 PN/DP
D 11 CPU 316
H13-04B0 i<|
memory; 0.1 ms/1000
ROFINET connection; 57
4 | oK | C; | Help | n (loadable FBs/FCs): LI
Insertion possible . Ml Cha 2

Figure 12 -- PROFINET Network Added
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Add Drive w/ SI-EP3 Option to PROFINET Network

Select SI-EP3 from catalog

Drag SI-EP3 to network

Select Object properties from the Edit menu
Enter the SI-EP3 name and device number
Enter SI-EP3 IP Address

Select the network connection

Select OK

Select the cyclic I/0

Drag the 1/0 to the designated slot

Right click on memory and select Object Properties
Select Parameter tab

Select Control and Status Word Selection
Select either PROFIdrive or Yaskawa
Select OK

E' HW Config - [SIMATIC 300(1) (Configuration) — PROFInet]

@l Station Edit Insert PLC View Options Window Help == x|
D% gig|ne damo B
2 ol xl
= (0) UR : -
R | End | nﬂ “fl
AZ’?‘ iﬁ':uj/;;s_z NI J Profile: ISlandard j
PROFInet: PROFINET-I0-5; 100
x PNHO - ystem (100) = B PROFIBUS DP =
x2ri||f Por 7 i ~D %8 CoOpiBUs Py
3 ~I a -4 PROFINET 10
4 E -— .g T+ Additional Field Devices
= -~ {0 Drives
Select SI-EP3 0 SHEF3
wlg 51-EF'3 Frofinet Option
From catalog and FI—a, .
Drag it to the network ()
{231 Metwork Components =
1| i
SIEP3 H
V'askawa America, Inc -l
> | ||S-EP3 PROFINET 10 module
4 | » GSDMLYZ 2 askawa-SIEP3-20100726. 4l
Insertion possible [ [ [cha 2

Figure 13 -- Add SI-EP3 Drive to Network

[ HW Config - [SIMATIC 300(1) (Configuration) —- PROFinet]

@y station | Edit Insert PLC View Options Window Help _1= =
Copy CtrlsC 7
g. C =1
Paste Ctri+y:
Insert Redundant = . El%'
1 Delete T Find: I ﬁﬂ ﬂh!
. 2 2
Select Edit X1 Select A1l Ctrlsh Frofil: | Standard =]
PROFInet: PROFINET-0-5: (100]
e GoTo v - en 00 = ¥ PROFIBUS DF =
X2r1 .22 PROFIBUS-PA
3 =588 PROFINET 10
4 e : - £ Additional Field Devices
. . E PROFINET 10 * =] Drives
Object Properties == Isuchronous Mode =3 SI1EP3
= 5Pt Opn
Open ObjectWith... Ctrl+AH+0 {1 Gateway
= & 1o
Assign Asset ID... LB -3 Metwork Components _|L|
Start Device Tool 4 | B
SIEF3 £<|
v'askawa America, Inc -
| ||SI-EP3 PROFIMET 10 module
1| | » GSOMLAZ 27 sk awa-5IE P32 0726 i
Displays properties of the selected object for editing. [ [ Chg

Figure 14 -- Configure SI-EP3 Option
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V

with Siemens Step 7 Software

General |
Short description SI-EP3
I-EP3 PROFINET 10 moduls d
Enter Device Name [ HW Config - [SIM &l
E~aigtion =8|
Order No. / Firmware: ~ SI-EP3./V1.0
SIHER3
olx
Device name NW Conveyor 5
1 (4] | ﬂi.l
2 CPU: =
. X MPLE
Enter Device Number ~J_|x PAHO z
e[ Par;  GSDfle GSDMLV2 2-Yaskawa-SIEP3-20100726 xml
3 \ Change Belease Mumber, |
i Devices
=
MET IO System
Device number: |1 j IF‘FlﬂFINEI'—IO—System (100) £ F'3 Profinet Optian €
IF address: 12 6l Ethemet ...
nents -
SeleCt Ethernet [V Assign |P address via 10 controller I _.I_I
To set IP Address T ﬂ
¢
Comment: <
le
4 I ;I P3-201007 26.xml
Press F1 to get Help. =l [che s
Grod | _tr_|
Figure 15 -- Add Name and Device Number
General |
Short description SI-EP3
P-EF@ PROFINET 10 module ;I
Properties - Ethernet interface SI-EP3
Enter IP address M Order No_ 4 General  Parameters | =TT
nEe-8 8
Family:
—=TE|

: nj: wﬂ
2
= =
2 PN-O - Gateway «
X2P7 Pot 7 GSDfile: i::dmg( % oot use router
3 bnet mask: -
Use rauter .
Select network 2 s [ Devices
- e Address:  [192.1682.20
Connection =———___| N bt I
\% — not networked — ey FF3 Profinet Option [
IP addres
Select OK frpates ohents —
¥ Assig Delete _I LlJ
5,
\[_:ummen[_ A
=}
4 Cancel | Hep | =l | [Pa20100728 i
Press get Help. LI W A
oK | Cancel Help
Figure 16 -- Add IP Address and Network Connection
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

@y station Edit Insert PLC View Options Window Help =12 x|
(D=8 §a ee | aa bD 2
= p=I|
:’ =
1 AI Find: I EI&I
Select cyclic I/O ~— ol 7 — J Brofle: [Standard =
Drag it to the ~:g? D PROFlnet: PROFINET-IO-System (100) _—Fi,;l e -
i PROFINET 10
Designated IO slot < = Additionsl Fisld Devices
4 =] Drives
J° =1 SIEP3
EE SI-EP3 Profinet Option

[ HW Config - [SIMATI

) (Configuration) — PROFInet]

:I:I [1] MNw-Conveyor

E1+_ Drive Object

1040 Prafile
Std Tgm 1
Slat I odule Order number | Address | O address Diagnostic add.. &
M -Converer SHEFPR S -
Aarses SEE
Al Sl - SI-EP3
Pt — i Std Tgm1 + 5 P20 Module
= = GSDMLAZ 227 askawa-SIEP3-201 00726 #ml
-~
Press F1 to get Help. | [ chg 4
Figure 17 -- Add Cyclic 1/0
Copy Ctri+C
Paste Ctrl+y
Add Master, System
Dizconnect Master System
Insert PROFIHET| 10 System
[ HW Config - [SIMATIC 300{1) (Configuration) — PROFInet] Disconnect PROFIET 10 System
@ staion Edit Insert PLC View Options Window Help PROFINET 10 Domain Management... =12l x|
D&%8 B8 el dadaH= %8 k‘?| PROFIHET I0 Topology...
Isochronous Mode -
x|
Specify Module... =
= n:l; ”i'l
. . Delete Del
Right click on I/O slot & L o2 PvDP = =l
PO PROFinet: PROFIN  GoTo ¢ 5
Fort 7 T Filter As=igned Modules "
BNy Monitor/Modify ]
Select N < T
. . N = Edit Symbols...
Object Properties 5 ~ > R LT - Coriol 300400
SN Open Object With... Ctrl+AH+0 Station
:I:I [1] Ww-Carveyor Assign Asset ID...
@A Modue Qider ber | Address e] Product Support Information Ctri+F2
N@-Lonvesor SIEFF N FAQs Ctri+F7
A7 [ wiiace Find Manual Ctri+F6
N I
Start Device Tool = for SIMATIC 57, M7, f<|
AT Tk -
Displays properties of the selected object for editing. | v
Figure 18 -- Cyclic I/O Properties
9 May 2012. Document: AN.AFD.31 Page 9



Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Properties - 5td Tgm 1 + 5 PZD - (R-/51)

BTNl Generol | Addesses Parameters |

=10]x]
By station Edit | _ =] x|
—_— Walue
J D Bq 2“‘ [5:'\', Ea Parameters
o
0 ="
Select Profile 1 5 LYY
\ 2 CPU 3 j
UBY MPUDE
o~ Pv0 .
X2P1 0
3
4
= [}
4 askamwa j Control 300/400
- M3 Output Parameter 1
!I:I 1] Nw-Cy L[] parameter number PROFIDiive
1§ Output Parameter 2
L[] parameter number 0
£H-§ Output Parameter 3
L[] parameter number 0
1§ Output Parameter 4
SeleCt OK L[] parameter number 0 MATIC 57, M7, H
£H-§ Output Parameter 5 =
L[] parameter number 0
~
Cancel Help
Figure 19 -- Control and Status Word Configuration
9 May 2012. Document: AN.AFD.31 Page 10



Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Assign Device Name

All PROFINET devices must have an assigned name. Assigning a name to a device requires that the device be connected to
and can be seen by the network. Although it is not necessary to assign device names at this point, the process is shown here.

300({1) (Configuration) — PROFInet]
PLC View Options Window Help ==l
Select PLC e [[[1 & 5~ H §|&g Download- Gttt
= D=l
= (0) UR Download Module Identification... Find: I =
[ Upload Module Identification to PG... e Elﬁl
gl e Fiofle:  [Standard =
NET-I0-5) 10
g - Module Information... Ctri+D R e - PROFIEUS DP
Qperating Mode... Gl ,ﬁ’ﬁ! PROFIBUS-PA
3 = B2 PROFIMET IO
4 S;"T’_— SM'I']' SIMATIC 300
3 Ve SIMATIC 400
Select Ethernet \ Llupiiunileiny : SIMATIC PC Based Control 300,400
1 e — -8 SIMATIC PC Station
Save Device Hame to Memony Card...
e trorntode
Select ‘—I—I PROFIBUS » Verify Device Name... US-DP slaves for SIMATIC 57, M7, and C7 [distributed £ ¢
Assign Device Nam E
§§ g evice Na ¢ :I:I [1] NwCorveyor Save Service Data... =T e
— i f i i i
Assignment of PROFINET IO device names. [ Chg 2
Figure 20 — Assign Device Name
[ HW Config - [SIMATIC 300(1) (Configuration) — PROFinet] E[=1E
“ Station Edit Inserl QEENIEENIRET H =18 =l
2., g =
J O = &~ EH | = Device namee | My Corveyor vl Device type: |SI-EP3
ozl
. . Auwailable devices: o
Verify Device name — . . | iy
2 CPU 3152 IP address | MAC address Device type | Device name Assign name j
o Nade flashi
: test
Select Device == 22 I iziee AR
X2r1 FPort 7 Duration [seconds]: 3 Vl
3
4
=
Flazhing an | Flashing aoff, | /400
. s
Select Assign name =
I~ Show only devices of the same type | Display only devices without names
Update Export...
Select Close | E— | ! M7, and C7 [dstibuted T
ST ey, O | _ Hep |
—
Press F1 to get Help. | | Chg
Figure 21 -- Assign Name Dialog
9 May 2012. Document: AN.AFD.31 Page 11



Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Save, Compile and Download

e Save and compile the configuration
e Download the configuration to the PLC

:..—; HW Config - [SIMATIC 300(1) (Configuration) — PROFInet]

Station Edit Insert PLC View Options Window Help _1= =
New... Ctri+N = | am | k"|
open... Ctri+0 z
. = o
Select Station § OpenONLINE B LI
Close Find: I ﬂﬂ ﬂﬂ
Save Profile: I Standard j
. PROFInet: PROFINET-O-System (100) -
Save and Compile = |~ ., —— ¥ PROFIBUS P4 -
HIIYEL =85 PROFINET IO
B3 Additional Field Devices
Import... H ED Drives
Eli B2 51EP3
—  Consistency Check Ctri+AltsK E-@ SIEP3 Profinet Option
4 Check CiR Compatibility: Ctrl+Alt+F E‘"r—:'_ ”"Eag';f;ﬁla
= P g sdTam
B CLEE | Address 0 address Diagnostic add... | C... | E 5 dTgm1 5F
Print Preview... D [ - td Tgm +_|L|
Page Setup... R | | B
T SIEF3 ¢
T T L EILE S A Std Tam1 + 5 FZD Maduls =
2 PROFInet|SIMATIC 300(1)(1) .55 EnmE | G5DMLY2. 2 askawa-5 EP3-20100726.4ml
3 YALHQISIMATIC 300 Station =

say 4 PROFInet\SIMATIC 300 Station | |

g
N

Exit Alt+F4

Figure 22 -- Save and Compile

_1&] x|
p=TE|
i Download Module Identification... z :
T Upload Module Identifieation to PG... End | ﬂlﬂl
2 CPU3152P :
Select PLC X7 Faulty Modules.., Profile: IStandard -
ET-10-System (100} -
Download g - Module Information... T Y PROFIBUS-PA -]
Operating Mode... Cirl+ !ﬁ’ﬁl PHDFINFT 1a %
3 B Additional Field Devices
Clear/Reset... n .
4 3 = ED Drives
‘ £ Set 'I_'lme of. [lgv _»lJ E‘D SIEP3
dlugiton i lodiiy g SIEP3 Profinet Option
= =+ Drive Object
:‘:I 1) Nw-Comveyor Update Firmware... A 1040 Frafiie
i Std Tam 1
Save Device Hame to Memorny Card... Fiey || e e [B | [ gm
H SidTgm1+5F &
e R E s o
ST
PROFIBUS 3 T SIEF3 Ly
B Std Tgm1 + 5 FZD Madule
StdTom1+ 52T Save Service Data... 5 GEDMLY2 2 askamwa-SIEF3-201 007 26, 5ml
Loads the current station into the load memory of the current module. [ [ v

Figure 23 -- Download to PLC

9 May 2012. Document: AN.AFD.31 Page 12



Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Drive Control Programming

Variable table

Populate the Variable
Set Mode to Online
Enter Drive Variables

Create Variable Table
Name the Variable Table

table with Drive I/O

Press F9 to Send Modified Values

r_.J‘S\MATIC Manager - [PROFInet — C:\Program Files\Siemens\5tep7\s7proj\PROFInet]

File Insert PLC View Options Window Help =1l
= |23 station Y (&1 |[< o Fiter> Dw (% E (BB M|
/ o8 PROFIRe o 00et " femdata 0BT
Select Insert S siMe  Program -
S7 Block =0 s7sonware »
; — BELTTHI 1 Oroenization sock
Variable Table \ M7 Software » 2 Function Block
| bol Tabl i
Banbol Tuils 4 Data Block
e 5 Data T\
External 50! - e
Inserts Variable Table at the cursor position. i

Figure 24 -- Create Variable Table

r__-.J‘ SIMATIC Manager - [PROFInet — C:|

File Edit Insert PLC Wie (el it=EmE R R E = S
Ei =l&l x|
= = E; F o
Enter Symbolic Name - D& |87 | & B Geneel-Part 1| Generl-Pa 2] At | x|
CE SIMATIC 3000 Lae [T
=] CPU 3152 PN/DP Symbolic Name: » |NWCon\reyor7I0|
=] 57 Program(1]
(B Souces Symbol Commet: I
“(cH Blocks
Project path: I
3‘::?:;0‘21”” |C:\F‘mgram Files".Siemens".Step 7s 7pro)\P RO Finet
Code Interface
Date created: 12/14/2011 12:02:35 FM
Select OK Last modfied: 12/14/2011 12:02:35 PM 12/14/2011 12:02:35 PM
Comment ;I
~
=
—ox | i
Press F1 to get Help. T TTCP/P(AUT) > ASIX AX85178 USBZ0 | 7
Figure 25 -- Name the Variable Table
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

ik ™
T T T >
Ej Hle Edit Insert PLC = tdit In=ert FLC Va = Opfions Help _18] x|
= 5 o B2 9
D 8w s me 2 DSl 8 4e]o|-] x| =ls| ¥ Yls mnamvl
=-£2p PROFInet B NWConveyor_I0 — PROFinet|SIMATIC 300(1)\CPU 315-2 PHIDPST P... =]
Bl SIMATIC 3001) ] Address | symbol| Display format| Status value WMadify value
2 '—'53;2'2 P ?PF RS B
(0 57 Programilf |5 s HEX
3 | Pw 260 HEX
Enter Inputs — B =
PIW [Input Address] 5 | Pw o264 HEX
B | PwW 268 HEX
7| Pw s HEX
v B
Plla| paw 28 HEX
| Paw 258 HEX
1| Paw 260 HEX
Enter Outputs »< |[12| raw 262 HEX
13| Paw 264 HEX
PQW [Output Address] —  prie ok
|[7E]  Paw 2es HEX
16
Press F1 to get Help. Press F1 for help. o ol y
Figure 26 -- Populate Variable Table
B var - [WConveyor_ID — PROFInet\SIMATIC 300(1)\CPU 345-2 PNIDPST Programi1)]
. B FieEdit_pce 2 Tablawfditeinoert==PedPl Varible View Options Window Help e _|8]
Select Variable m— = — = =
D& |82 7| w| D|S(E| & 4|z 0o 6 | €|ﬂ|ﬂq|ﬁ|‘ x2 |
B FRorna
o A m Display i iy CtrlsFo fy value
: 1 PIN 256 BIN
. i _— "
Select Monitor =" B & <7 5 St HEX Ipdate Monitor Values FT
E) P 280 HEX Activate Modify Walues F3
4 PV 262 HEX Modify Address to 1 Ctriv
s P 264 HEX Modify Address o 0 Ctrl+0
6| PW 286 HEX
7 PMW 268 HEX Enable Peripheral Outputs  Shift+F8
8 Display Force Values Alt+F2
9 | Paw 2% BIN i
10|  Paw 258 HEX Stop Forcing
11| Paw 260 HEX
12 PQW 262 HEX Modify Value as Comment F3
13| Paw 264 HEX
14| Paw 268 HEX
15| Paw 268 HEX
16
PressF1togetHelp.  Starts/Stops the monitoring of the variables depending on the trigger co 2 [offine |abs < 5.2 ,; _| v

Figure 27 -- Set Table to Online

9 May 2012. Document: AN.AFD.31 Page 14



Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

PROFIdrive
[EB] Var - MW Conveyor_I0 — @PROFInetiSIMATIC 300(1)\CPU 315-2 PN/DP\ST Progr... [-T0] =] H[=E
£ File Edit Inse {3 Table Edit Insert PLC Variable View Options Window Help  _ |3 x| =181 x|
D2 |8 & - Dislal 8 %[l x| [ 2] || Sl v soE [ BS DN
E-&) PROFInat AT Address | Symbol| Display format| Status value Wodify value
= )
Read 1 1 Py 2 ZH0000_0011_0011_0111 PZD1 (STW)
Status Word Tan o7 2| PW 258 el © VEE1E#1770 PZD2 (HIW)
Reference Frequency ]|l 20 e UTAETID s
Lgm [A] Pwo2e2 HEX WE1B£0000
s | P 284 HEX WH16£0000 PZD5
& | P 2es HEX WH16£0000 PzD6
PZD7
. 7| Pwo2sE HEX WHIE#0000
Write 5
Control Word' - - > s E;g; :ilTsvv\\I/))
- HE AL, = \#6E1TT0
Frequency Reference o L = PZD3
12| Paw 262 HEX 24 E;gg
Press F9 to Write 13| iPaw 264 i £ PZD6
. 14| Paw 268 HEX 24
Modified Values = = - PzD7
To the Drive 16
PressF1togetHelp, PROFINet\SIMATIC 300(1)\...\57 Program{1) < RO /[ y

Figure 28 -- Enter PROFIdrive Control Values

Control and Status words for the PROFIdrive profile selected in the Cyclic I/O Configuration. Note that the Control and
Status words for PROFIdrive profile are not the same as for the Yaskawa profile.
PROFIdrive: Control RUN 007Fh

Yaskawa
T Var - [NWConveyor_I0 — @PROFInetSIMATIC 300(1)\CPU 315-2 PDP\S? Pro... To[O]=]
Ej Fie Edt Insert PLC 43 Iable Edit Insert PLC Variable View Options Window Help ;|g|5I 13|
D= |2 & B E = - EEDH?‘
Read 1 o | DI(E| & & [8(e[o]| ][5 8] W] e o 5]
ca 2 = SIMATIC 3001] £l Address | Symbol| Display format| Status value Madify valug
Status Word - . — = $  2:1100_0000_0010_0001 PZD1 (ZSW)
Reference Frequency m— = — NEIEEIC PZD2 (NIST_A)
! y (D Sowrees 3T B 360 HEX V1640000 PZD3
o Blocks T e HEX V1650000 PZD4
5 | w264 HEX VWH16#0000 PZD5
Writ 6| PN 26e HEX VW E£0000 PZD6
rite 5 7| P 262 HEX VW E#0000 PZD7
Control Word B
Frequency reference | Rl 25 e, PZD1 (STW)
! y 0 PO 2o TR » =) VIEIEH1TT0 PZD2 (NSOLL_A)
11| Paw 280 HEX 4 PZD3
12| Paw 262 HEX 4 PZDA
. 13| Paw 264 HEX pe
Press F9 to Write — i e g i
Modified Values 18] Paw 268 HEX # PZD7
To the Drive E
Press F1to get Help. PROFINet\SIMATIC 300(1)\...\57 Program(1) 4 fn | 4

Figure 29 -- Enter Yaskawa Control Values

Control and Status words for the Yaskawa profile selected in the Cyclic I/O Configuration
Yaskawa: Control RUN 0001h
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Ladder Logic (LAD)

Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Control the Drive From the PLC Program with PROFIdrive Profile Selected

One Shot the command to
Move the RUN command
To STW (PZD1) and the
Frequency Reference to
HSW(PZD?2)

One Shot the command to
Remove the RUN command
To STW (PZD1) and the
Frequency Reference to
HSW(PZD?2)

ES LADISTLIFBD - [0B4 — PROFInet\SIMATIC 300(1)\CPU 315-2 PN/DP]

I} File Edit

Insert PLC Debug View Options

Window Help

DEsEE =R

o o | Gl [0 | 25 60 | 1< ! [DE| E2[4F 4 -0 BT L 2 = [N2]

zlxl

Contents Of:

"EnvircnmenthInterface”

-~ New network
+-(a1] Bit logic

(%] Comparator
(25 Converter

(1] Counter

+-(DE] DB call

H-(g] Jumps

-(2I] Integer function
t-(2§] Floating-point fct.
(=] Move

-3 Program control
(] ShiftRotate
-{az] Status bits

(@] Timers

(35 Word logic

-{gH] FB blocks

H-{gH FC blocks

H-{gH SFB blocks
H-{gH SFC blocks

- fill Muitiple instances
- Libraries

Bit logic

%

N Program e... |E§_E Call stru

E-43 Interface
[-4@ TEMP

|Name

g [TEME

a

m: Set PROFIdriwve RUN and Frequency

Set Drive RUN

On M1.0 Positive Edge Trigger True

Set Frequency Refence to 60.0Hz

Ml.0 Mz.0

_‘I { o)

Wgleg 7F | IN

OUT |-BEW256

WELE§1770 | IN

MOVE
ENC—

OUT |-DQWzss

Network 2 : Set PROFIdrive STOF and Zero

Frequency Reference

Set Driwve STOP

Cn M1.0 Dositive Edge Trigger False

Set Frequency Refence to 0.0Hz

Press F1to getHelp.

Ml.0 Mz.1 WOVE
——1 {p} =N ENG
WELEE0 - IN OUT |-PQWZS6
MOVE
EN ENO [

WELEED - IN OUT |-PQu2S8
] |

D [offine [abs < 5.2 [w1

-

fnsertfchg [ 4

9 May 2012.

Figure 30 — Basic Drive Control Program
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Change the Acceleration Rate When the PROFIdrive Profile is Selected
o Enter the acceleration parameter address in F7-33 with the value desired.
o Parameter C1-01 (0200h)
e Power cycle the drive to store and make the parameter value active.

_"'T‘l LADISTLIFBD - [0B1 — PROFInet\SIMATIC 300({1)\CPU 315-2 PN/DP]

I} File Edit Insert PLC Debug WView Options Window Help _|5||5|
Dee WS s Do o |ehan|[o] 261! [DEE[HF# O L = |82
==l Contents 0£: 'EnvironmenthInterface'
E-@ Interface |Name
9 New network [-4g TEMR EjE=E
-5 Bit logic =
[#-{¥] Comparator
[+-{&g] Converter =i
[#-{z4 Counter Network 3 : Change Accel Rate (Yaskswzs or DROFIdriwve)
[+-{ZE] DB call
5] Jumps Program F7-33 to 200h (address of C1-01)
Drive Must Be Rebooted in Order for Dynamic Varisbles to Be Stored
el Integer function On M1.1 Positive Edge Trigger Set C1-01 to 10.0 §
[#] Floating-point fct.
: [#-{z] Move
One Shot the Change mn [+-{3f] Program control M1.1 Mz .2 WOVE
Value to PZD3 [+-{z5] ShiftiRotate } (e} EN  ENO
[+l-{ai7] Status bits
[#-{@] Timers WELEEE4 —|IN OUT [~ PQWZ 60
[#-{Z Word logic
[-{£H FB blocks
#-{£H FC blocks
[+-{£H SFB blocks
[+-{£H SFC blocks
il Multiple instances
[]----‘ﬁ Libraries
Bit logic Bl
[ Programe... E_ECallstru.. | ﬂ_l LlJ
Press F1 to get Help. =) |of‘Hine Insert [Chg v
Figure 31 — Control Acc Rate
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software
Notes
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